Table of Contents

Introduction 3
General 4
Report Manager / Viewer 6
Report Designer 8
Connector 14
1.0 Introduction
The following document provides answers to some frequently asked questions about Sage Pastel Intelligence Reporting (Intelligence Reporting). This document is a supplement to the User Guide, Help File and Installation Guide documents.

1.1 Topic Summary

<table>
<thead>
<tr>
<th>Topic</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Questions relating to general reporting requirements and installation and/or upgrade considerations</td>
</tr>
<tr>
<td>Report Manager</td>
<td>Questions about the Report Manager module</td>
</tr>
<tr>
<td>Report Designer</td>
<td>Questions and useful information about the Report Designer</td>
</tr>
<tr>
<td>Connector</td>
<td>Questions about the Connector Sage Intelligence module which address more advanced reporting capabilities such as consolidating data and catering for non-financial reporting needs</td>
</tr>
</tbody>
</table>
2.0 General

2.1. Can Intelligence Reporting connect to any database type?
Intelligence Reporting supports all ODBC drivers. Intelligence Reporting has a preconfigured connection and predefined financial templates for the Sage Pastel Accounting Pervasive database. You will be able to set up a connection to any other database in the Connector should you wish to report on information from other data sources. For more information on setting up connections in the Connector, please refer to the Intelligence Reporting Help File.

2.2 Which operating systems is Intelligence Reporting compatible with?
- Windows 7 (32 and 64 bit)
- Windows 8 (32 and 64 bit)
- Windows Server 2008 R2
- Windows Server 2012

2.3. Can Intelligence Reporting run on Windows operating system 32bit and 64bit?
Intelligence Reporting supports both 32 and 64 bit versions of Windows.

2.4. Is Intelligence Reporting compatible with Microsoft Office 32 and 64 bit?
Yes, Intelligence Reporting supports both 32 and 64 bit versions of Microsoft Office. Supported versions of Microsoft Office for version 14 include:
- Microsoft Excel 2007
- Microsoft Excel 2010 (32 and 64 bit)
- Microsoft Excel 2013 (32 and 64 bit)

2.5. I am currently using an older version Intelligence Reporting, how do I go about installing and updating my Intelligence Reporting Software?
It is recommended that you make use of the information detailed in the Sage Pastel Accounting Installation Guide when upgrading your software.

Note: Your old reports will run out and function as they did before you upgraded the software. Upgrading will not affect your existing report templates.

2.6 What reports come standard with Intelligence Reporting?
Intelligence Reporting comes standard with a new financial report designer template catering for your unique financial reporting needs as well as a new look and feel for the non-financial report templates.

Demonstration Financial Report Designer 1-0 (Pv14)
The Demonstration Report Designer report contains sample financial layouts such as Income Statement, Balance Sheet and Cash Flow based on Sage Pastel demonstration data. The revamped report designer includes a Task Pane and enhanced Layout Generator to empower users to take control of all design aspects of their reporting layouts.

Financial Report Designer 1-0 (Pv14)
The Report Designer report enables you to create financial layouts based on their Sage Pastel Accounting data. The revamped report designer includes a Task Pane and enhanced Layout Generator, both utilizing a powerful in-memory engine, empowering users to take control of all design aspects of their reporting layouts. The Layout Generator contains four pre-defined layouts including a Balance Sheet YTD, Income Statement Actual vs Prior, Income Statement Actual vs Budget, Income Statement for the current period YTD and a Trial Balance.
2.7 Why would I want to convert my existing Excel Genie reports to the new Revamped Report Designer report?  
The revamped report designer improves your experience in the following areas:

1. Performance – improvements in performance of financial reporting due to use of powerful In-Memory technology.
2. Account Roll Ups - ability to cater for ranges of accounts, wildcards as well as account exclusions.
3. Flexibility - 100% native use of Excel allows you to be in control of how your reports are formatted making the design and maintenance of financial reports/financial packs much faster and easier.
4. Ease of Use – Use the Layout Generator, powered by the In-Memory technology, to automate and fast-track your financial report design.
5. Drill down - Simple right click drill down to balances and transactions from within Excel.

2.8 Can I preserve formulas when distributing Sage Intelligence reports?  
Yes it is possible to preserve report designer and excel formulas when distributing reports. In order to preserve formulas when distributing reports you can do the following:

1. Format the cells containing the formulas you would like to preserve as locked
2. Turn on protection for the worksheet
3. Distribute the worksheet
4. Note that formulas are retained in the distribution.

Please refer to the Intelligence Reporting User Guide for more information on how to preserve formulas during report distribution and on how to lock and protect Excel worksheets.
3.0 Report Manager

3.1 It may be useful to make certain reports visible only when connecting to a specific database. Is this possible?
Yes. There are two methods to ensure that certain reports are visible only when connected to a given database.

Intelligence Reporting provides the concept of scoping, where a report can be scoped or made available only when connected to a specific database. A report that is deemed useful across all databases should be Scoped Globally which is the default for each report. Users can manage scope by right-clicking the Home icon in the Report Manager and selecting the Manage Object Scope and specifying the scope of each report relevant to the database.

Access to reports can also be restricted via the Security Manager. Users can create a role with access to only certain reports and assign users to that role in order to restrict user access to Reports within the Report Manager module.

3.2 Is there a way to see what Container a Report is using?
Yes. In the Report Manager ensure that report is not locked. Double click on the report in order to view the containers used by the selected report.

TIP: To Unlock a locked report you must copy it and paste it into a folder. You will then be able to view the report properties as well as its underlying containers.

3.3 Is there a way to run all the reports in a folder?
Yes. In order to run all the reports in a folder, select the relevant folder. Under the Tools tab select the option to Run All Reports. This will run out all reports within the report manager folder selected.
3.4 Are Intelligence Reports automatically backed up and where are the reports backed up to?
No, you will need to do a manual back-up of the reports. To do this go to the Report Manager module select the File tab. Select the Backup Metadata option which will ensure that the existing reports are backed up to the location specified.

3.5 Is there a limit to the number of reports in the Report Manager or folder?
No.

3.6 Are there any limitations or specifications in naming reports?
No, Reports and Template names can contain alphanumeric as well as special characters. It is recommended to use meaningful names for reports and sub reports.

3.7 What is a Sub-Query Report, and when would you use it?
Sub query reports are used to retrieve and aggregate data from more than one data source to create a single report which contains all the aggregated data. This is known as a Union report. A Union Report is therefore a group of sub query reports running together in a specified order, with the control to deliver all the sub reports' data into one workbook. This is critical as it eliminates the need to manually consolidate information from multiple Excel workbooks into a single workbook. Sub query reports are used to present data together in a single workbook that is unrelated, or comes from various data sources.

Although Union Reports are a series of sub-reports, they are treated as a single entity. The Report Designer report is an example of a Union report.

3.8 Is there a limit to the number of sub-reports that can be used in a union report?
No, there is no limit to the number of sub-reports that can be used, however, the number of sub-reports used will impact the performance of the union report.

3.9 Can you Export multiple reports from within the Report Manager?
No. You must export each report individually from the Report Manager Module.

3.10 Can you Import Multiple Reports into the Report Manager?
Yes. You can make use of the Bulk Import option available in the Tools tab of the Report Manager module. The Bulk Import Tool imports all reports in the Report Update folder on the auto connect connection.

3.11 Can you create custom system variables to use as Filters or Parameters?
Yes. To create filters and parameters based on system variables select the report inside the Report Manager and in the properties screen select the appropriate tab. You can then add a filter or parameter based on a defined system variable.

TIP: To view system variables select System Variables under the Tools tab in the Report Manager. The set of available System Variables defined can be extended by adding custom system variables to the Alchemex.ini file under the section [GlobalSysVars].
For more information on how to add custom system variables please refer to the Help File.

An example of two custom System Variables defined in the Alchemex.ini file is shown below. With this example the System Variables @FINYEARSTART@ and @FINYEAREND@ will be available to all reports in Intelligence Reporting.

```
[GlobalSysVars] Active=@FINYEARSTART@,@FINYEAREND@
@FINYEARSTART@=01 March 2011
@FINYEAREND@=28 February 2012
```

3.12 If you have not ticked the Mandatory option on a Parameter property could you run a report without entering parameters?
Yes. A report will run out successfully with no parameters specified where the parameter is not mandatory.
4.0 Report Designer

4.1 What is different about the revamped Report Designer and In-Memory Technology?
The revamped Report Designer has incorporated a Report Designer Task Pane as a layout design option which empowers users to take control of all design aspects of their reporting layouts. The enhanced Excel Genie, now known as the Layout Generator, remains part of the Report Designer as a layout design option should you wish to make use of it's more structured and guided layout automation.

The model behind both the Task Pane and Layout Generator are based on Excel financial functions which communicate with the In-Memory Database (IMDB) and processing engine which will guarantee performance by being able to crunch financial numbers very quickly.

4.2 Why does the Report Designer need two designs options?
In introducing the Task Pane as a design option we are providing solutions to end-users who wish to take complete control of designing and maintaining their reports in Excel but find it difficult to easily get the information they want into Excel without some help.

What areas or aspects does the enhancement affect?

<table>
<thead>
<tr>
<th>Area</th>
<th>Old Financial Designer Reports</th>
<th>New Report Designer Report using Task Pane or Layout Generator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance</td>
<td>One large data request is sent to the database which can sometimes be slow depending on GL account volumes.</td>
<td>Multiple small data requests are sent to the database which are efficient and quick.</td>
</tr>
<tr>
<td></td>
<td>Returned data is a single usually large table.</td>
<td>Returned data is a set of smaller tables which contain no redundant data, greatly reducing report size and speed.</td>
</tr>
<tr>
<td></td>
<td>GL data formulas inside report layouts can sometimes be hard to understand and slow to process if many reports are created within one Excel Workbook.</td>
<td>GL data formulas inside both Task Pane and Layout generator report layouts use simple Excel functions which utilize a fast In-Memory Engine to process data requests.</td>
</tr>
</tbody>
</table>
Ease of Use

GL data formulas are system generated and difficult to modify manually.

Changes made in Excel after generating a report are not always easily reusable in new reports.

GL data formulas are designed for end-user usage and are simple to understand and use. The Layout Generator also makes use of these formulas allowing users to easily customize their automated layouts.

The reusable report pieces available can easily be copied and pasted from one layout to another.

Accessibility to data

The current Layout Generator within the Report Designer module is a great tool but doesn’t provide me with easy & complete control over all aspects of my report.

Users need to invest a lot of time learning how to change the backend of reports to do requirements like 5 year trends and multi-budget reporting.

Allows users to dictate control over each individual Excel cell of the report ensuring maximum flexibility and control using the Task Pane.

Creating Multi-year and Multi-budgets reports financial will be easy via the use of simple report run-time options.

4.3 Which Report Designer Tool should I use?

Depending on the level of control you would like in the design of your report and your knowledge of Microsoft Excel, the Layout Generator may be used to simplify generating reports, otherwise the task pane may be used. Follow the process below to determine the best option for you to design reports.

If you do not have an advanced knowledge of Microsoft Excel then the Layout Generator provides an intuitive drag and drop interface to design reports. If however, you do have an advanced knowledge of Microsoft Excel and are familiar with Microsoft Excel formulas then the Task Pane provides a complete solution to design your reports using powerful Microsoft Excel functionality giving you complete control.
Which feature you use will be determined by your reporting requirements summarized as below:

<table>
<thead>
<tr>
<th>Use Layout Generator When…</th>
<th>Use the Task Pane When…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your reports have been built for you and you rarely ever need to change them.</td>
<td>The accounts within your ERP system change frequently and your reporting requirements change frequently, requiring you to tweak report designs and logic often.</td>
</tr>
<tr>
<td>You don’t consider your reporting needs to be advanced or complex.</td>
<td>You need to be able to create and control advanced Financial Reports which suit your unique business needs.</td>
</tr>
<tr>
<td>You are happy for the cosmetic design and layout of your reports to be assumed, automated and you won’t make many changes thereafter.</td>
<td>You want to have full control over the design of your reports and want to be able to add or remove elements of the design easily after you have created your report.</td>
</tr>
<tr>
<td>You need to report on a single company</td>
<td>You need to create consolidated layouts for multiple companies</td>
</tr>
<tr>
<td>You only need to report off of a single budget code and don’t need to report off more than just current fiscal year and prior year only.</td>
<td>You need to be able to easily do multi-year (3 years and more) and multi-budget reporting.</td>
</tr>
<tr>
<td>You don’t need to include more than 5 report layouts inside each Excel workbook.</td>
<td>You need to include more than 5 report layout inside each Excel Workbook.</td>
</tr>
</tbody>
</table>

4.4 Why is performance of the Revamped Report Designer better than the old Report Designer?
There are two main reasons for the improved performance:

1. The database queries which are executed against the source database at run time have been simplified so the reports run out into Excel much quicker.
2. The Report Designer uses an efficient In-Memory engine which is much faster when loading data and calculating financial values.

4.5 I have spent a lot of time building my own templates with the old Layout Generator and have a list of my own reports now, how are they related to the revamped Report Designer and can I reuse my prior work?
If you wish to change your existing generated layouts to take advantage of the new features, you will be able to do so by swapping out the formulas which currently return financial values with the new drag and drop Formulas instead. You will therefore be able to reuse the structure, such as rows, and formatting of your existing reports.

4.6 I already bought the Connector for quite a lot of money, why do I need to buy the Report Designer module license if all I will be using is Excel?
You will be using Excel however you will also be leveraging the power and flexibility of the drag and drop lists and formulas in the Task Pane as well as the automation of the new In-memory Layout Generator made available via the Revamped Report Designer. These tools interact with the In Memory Database to ensure a fast and flexible reporting experience.

4.7 Can additional Excel calculations and formatting be added to the layout sheet and still use Reporting Trees?
To ensure that the layouts generated from the Layout Generator based on Reporting Trees retain calculations, you should ensure that these calculation have been created and added to the layout inside the Layout Generator tool using the Calculator. Formatting that has been applied to the Excel spreadsheet will not be applied to the layout generated with a Reporting Tree.

Using Reporting Trees from the Task Pane will allow users to make use of standard excel calculation and formatting without having to worry about losing these changes when updating the Reporting Tree.

4.8 Does the Report Designer work with Microsoft® Excel® 2003?
No, it only works with Excel 2007 and above. This is because it uses technologies that are not supported by Excel 2003.
4.9 When new account/s are added or deleted in the Accounting System, how does the Report Designer know?

There is no automatic alert that new accounts have been added. If you are generating a layout the new or deleted account changes will always be included in your new layout if you make use of account ranges and wildcards when designing your report and creating your layout generator row sets. Please refer to the Report Designer User Guide for more information on using account ranges and wildcards when designing your report.

The new Missing Accounts tool available in the Task Pane is recommended for viewing which accounts are not included in your financial layout(s). Missing Accounts will assist you in ensuring your financial layouts are accurate.

4.10 What does the toggle switch sign button do when you right-select a row field?

Credits in the General Ledger always come through as negative from your accounting system. The switches allow you to manage the sign control. For example convert the Sales figures from negative to record as positive in your report.

4.11 Are signs automatically “toggled” in standard out-of-the-box Report Designer layouts?

Yes signs are automatically toggled by default.

4.12 When would you want to use the Save Excel Template functionality in the Report Designer?

You would use the Save Excel Template if you want to save a specific Excel layout that you have customized. Once you have selected to save the excel template, when you run this report the layout you customized will be delivered in Excel.

Note: Once you have saved the Excel template to a report for a specific company or set of companies this report becomes specific to that company or set of companies, and will deliver incorrect results if used against any other companies. The reason for this is that when you create and link your report, a set of the General Ledger account numbers are stored on the layout making that report unique to the specific company’s set of accounts.

4.13 If you use the Report Designer to create a report, can you send it to other people to view?

Yes. They will be able to view layouts that you have generated if you save the workbook with the generated layout as an Excel workbook.

However, the other user will not be able to generate report layouts if they do not have the Report Designer licensed on their workstation.

It is recommended to use the new Distribution feature to share your Report Designer report with other people who do not have Intelligence Reporting installed and licensed as it automatically converts the formulas to values when distributing the report.
4.14 If you create a report using the Report Designer and send it to a customer, are they able to run the report if they don’t have the Report Designer?
Yes. They would need to import the exported report into their system, run the report using the Report Manager and have the result delivered into an Excel workbook.

Note: Once you have saved the Excel template to a report for a specific company or set of companies this report becomes specific to that company or set of companies, and will deliver incorrect results if used against any other companies. The reason for this is that when you create and link your report, a set of the General Ledger account numbers are stored on the layout making that report unique to the specific company’s set of accounts.

4.15 Can you export and import Report Designer reports?
Yes, you can export and import Report Designer reports in exactly the same way you would any Sage Intelligence report.

4.16 Can you use the Report Designer to create non-financial reports?
No, the Report Designer report is limited to financial reports.

4.17 Are you able to export layouts that have been created using the Report Designer?
Yes, layouts created with the Report Designer will be exported along with the report as long as you have selected to Save Excel Template in the Report Manager before exporting the report. Users are also able to use standard Excel functionality to copy layouts from one Report Designer report to another.

4.18 Can you create graphs from the Designer reports?
Yes, by using standard Excel functionality that links to your layouts you can make use of the latest Excel features to visualize the information on your layouts.

4.19 How do you install the Report Designer?
The Report Designer is automatically installed with Sage Pastel Accounting and Intelligence Reporting.

4.20 Do you have to have Intelligence Reporting to run the Report Designer or can I purchase a standalone license?
You need to have Intelligence Reporting installed in order to have the Report Designer license. Intelligence Reporting is installed along with Sage Pastel Accounting software and does not require additional installation. The Report Designer Module is licensed per site.

4.21 Can you copy Report Designer reports?
Yes, as you would any Sage Intelligence report. Reports can be copied by selecting the Copy icon under the Home tab in the Report Manager.

4.22 Can you run aggregated reports using the Report Designer?
Yes. Should you wish to aggregate data from two separate PVS databases you could set up a consolidation connection and then copy the Report Designer Containers and Report Template over to that connection. Running this report would then render data from both databases into the source sheets of the Excel report and thereby allow users to report on aggregated data.
4.23 How does the Variance button work in the Layout Generator calculator?
The Variance button aids in standard accounting calculations by automatically calculating the difference or variance between the selected amounts such as the variance between Actual and Budgeted amount.

Example:
If you did $100 worth of sales and your budget is $50 then the Variance is $50 and is a positive value.

If your cost of sales is $100 and your budget is $50 then the Variance is $50 and is calculated as positive, but should in fact be negative as you are $50 over budget.

The IS Variance calculation button aids for this.

4.24 Is the Report Designer compatible with Excel 2013?
Yes the Report Designer in Intelligence Reporting is compatible with Excel 2007 (32 and 64 bit), 2010 (32 and 64 bit) and Excel 2013 (32 and 64 bit).

4.25 Why does the Report Designer not have a Mapping Tool like the Excel Genie used to?
The Report Designer has introduced Row Sets as the Layout Generator alternative to the Mapping Tool. Row sets allow users to create their own rows based on account rules using account numbers, account ranges and wildcarding. For more information on how to use Row Sets please refer to the Report Designer User Guide.

When using the Task Pane you can simply create rows on your report using account rules which map directly to the accounts in your General Ledger. This means that there is no additional mapping required.
5.0 Connector

5.1 Is it mandatory for a user to have the Advanced version of Intelligence Reporting with the Connector module to be able to use Intelligence Reporting?
You do not require an Advanced License to use Intelligence Reporting. The Standard Intelligence Reporting License will give you access to the Report Manager allowing you to run existing reports to get access to real-time information and have the ability to make changes to existing reports, create new reports, set up parameters, establish new templates, and more. More powerful report-building capabilities are available in the Report Designer module. The Connector Module is available if you have the Advanced version of Intelligence Reporting and will give you access to unlimited multiple disparate databases and consolidating* data from multiple companies.

5.2 Why would I use the Connector Module?
The Connector further simplifies financial managers’ day-to-day operational tasks by providing access to the information they need from multiple sources and consolidation of data from multiple companies. The Connector allows for consolidations and connectivity to unlimited ODBC data sources and includes a graphical join tool to simplify database queries.

5.3 Is the Connector module a user or site license?
The connector module is a site license.

5.4 Can you add your own Connection Types in the Connector module?
The Connector module allows reports to be created off any ODBC-compliant database for an unlimited number of companies and databases. Users are able to add a new connection to any of the ODBC drivers. Intelligence Reporting has a preconfigured Pervasive connection which enables users to use Sage Intelligence to report on Sage Pastel Accounting Data.

5.5 How can I consolidate multiple companies’ data?
You can use the Consolidation Connection which is available in the Connector (formerly Administrator) module. Sage Pastel accounting now has the Consolidation Connection set up as a standard Connection.

You can set up new Containers under the Consolidation Connect or copy containers from the Pastel V14 (Auto Connect) in order to create Consolidated Reports. You can also import the report you would like to see consolidated against the new Pastel consolidation connect.

Importing your Report onto the Consolidated Connection is simple. You can follow the steps below to import your reports on a consolidated connection to be able to report on multiple companies data.
1. In the Report Manager select the folder you would like to import the report into.
2. Right-click and select Import Report.
3. Select the Report that you are importing. The Import Report window will open.
4. You can rename your report, and select the Pastel Consolidated Connect.

      ![Import Report Window]

5. The newly imported consolidated report will appear in the Report Manager.
6. You now need to set up the Database Consolidation List in the properties window of the report. Select the ellipsis button.

      ![Database Consolidation List]

7. Select the databases you wish to consolidate. They will then appear in the Database Consolidation List in the properties window of the report.
   You can now run your consolidated report into Microsoft Excel and customize it to suite your specific reporting requirements.

**5.6 What is the difference between the Auto Connect and Consolidation Connection?**
A consolidation connection allows users to connect to more than one Sage Pastel Accounting database. You can use the connector to create consolidated reports which make use of a consolidation connection to allow users to report on information from multiple databases. Auto connection is used for connection to a single database.

**5.7 What types of containers are available and is there an advantage to using one type of Container over another in the Connector module?**
Containers can be based on a database table, view, stored procedure, custom SQL query or a custom join based on two or more tables/views in a database.

Graphical Joins, existing views and SQL Joins are the preferred methods for creating containers and wherever possible these should be used. Stored procedures and SQL query containers provide less flexibility for end users creating new or modifying existing reports off these containers. For example: parameterization of reports built off SQL Query and Stored Procedure containers can only be achieved using pass through variables which is an advanced feature of Sage Intelligence.

**5.8 Why would it be better for you to use a SQL expression instead of excel formulas?**
Excel Formulas should be a last resort if the end result cannot be achieved through SQL expressions as Excel formulas have a negative effect on file size and performance.
5.9 Am I able to lock Containers?
Support for locking of containers and expressions in the Connector have been deprecated. Users are able to lock reports in the Report Manager module.

5.10 Is there a way to back up your containers?
Yes. In the Connector module select the File tab. Select the Backup Metadata option which will ensure that the existing reports and their containers are backed up to the location specified. To specify the backup location go to the file Menu in the Connector and select the Change option. You will then be able to specify the back-up location.

5.11 Is there a limit to the number of containers in the Connector?
No

5.12 Are there any limitations or specifications in naming Containers or Expressions?
It is recommended to provide meaningful names for expressions and data fields, as often database fields are presented in a cryptic manner.

5.13 Can you copy SELECT statements from other reporting systems and use the same statements in Sage Intelligence Connector?
Yes you can copy SQL statements when using a SQL Container. However be wary that depending on how the connection has been set up you will need to verify that these statements are valid by either Checking/Testing the container or selecting to Sample Data.

5.14 In the Connector can I add additional Expressions to the Report Designer Container? If so would those expressions be automatically added to the source sheets in the Report Designer?
Yes you are able to add additional expressions to a container. After adding expressions to a container in the connector you will need to add the expression to the relevant sub-report in the Report Manager as well before running the Report, which will ensure that the expression will be added to the correct report designer data sheet.

Note: The Report Designer will only load the preconfigured fields into memory. Any additional data rendered to the source sheets will not be loaded into memory and will therefore not be accessible using the Report Designer Task Pane or Layout Generator.